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Introduction

X-Analysis, allows technical analysts to graphically navigate through an iSeries application from a Windows PC. Working in a true client-server mode, X-Analysis automatically cross-references the database and ensures that what is displayed is always up-to-date and a true representation of the application on the iSeries.

X-Analysis is a tool for analyzing an application on an iSeries by viewing the Object/Member Lists, Data Flow Diagrams, Overviews, Program and Normal Structure Charts, Source X-References, File Usage, Source Code, Object-Where-Used, etc.

General Instructions

When running X-Analysis, execute the commands either by:

· Clicking on the relevant buttons on the Toolbar.

· Selecting the relevant options from the menu bar. 

· Selecting the relevant options from the right click menu.

· Double click selects the most obvious command.

· Function key F1 brings up X-Analysis help.

· The libraries are displayed on status bar for the selected application.

Getting Started

To use X-Analysis, it is important to ensure that all the necessary X-Analysis software is installed (on iSeries and PC).  This chapter details the steps required, to complete the installation and initialisation process.

X-Analysis can be installed onto the iSeries from CDROM.

It is recommended that you read this chapter thoroughly before commencing any part of the installation and initialisation procedures.

Checklist

Please ensure that all the items listed below are in place.

Authorisation Code

An Authorisation Code is required to run X-Analysis.  If you do not have an Authorisation Code, this must be obtained from Databorough by completing a Licence Code Request Form (see Appendix C).

System Requirements

1. IBM Compatible PC running Windows 98, or higher with Internet Explorer 4.0.

2. Physical connection of PC to the iSeries where the X-Analysis server software is installed.

3. Microsoft Office 97 for X-Analysis System Documentation and running offline version.

Preparing iSeries to run X-Analysis 4

1. Sign on as a suitably authorised user - i.e. a user that can create & restore libraries and who has sufficient authority to perform commands such as DSPDBR over the libraries to be documented. At the point where the command MMC@INST is invoked you will need to be signed on as the security officer or another profile with user profile creation rights.

2. Set the logging level. CHGJOB    LOG(4 00 *SECLVL)    LOGCLPGM(*YES)
3. If X-Analysis is previously installed then execute following command :

 ENDSBS SBS(XRMTCMD) Option *IMMED
4. Place the CD in the CD-ROM Drive.

5. Perform a LODRUN.

6. Review the job log(s) to verify that all objects were restored successfully. Print and save the job log. Use DSPJOB Option 4 and print the spool-file

7. Remove the CD from the optical device.

4. Continue with Post-Load Activities.

Post-Load iSeries Activities

Entering the Authorisation Code

Before X-Analysis can be used on the iSeries, the correct Authorisation Code must be entered. The Authorisation Code must be obtained from Databorough by completing a Customer Information Form (see Appendix C).

If an Authorisation Code form has been received, please check that the machine number stated on the Authorisation Code form is the same as the machine number on which X-Analysis has been installed. If there is a discrepancy, please contact Databorough.

To enter the Authorisation Code:

1. Add library XAN4 to the Library List:

ADDLIBLE (XAN4)

2. Enter the command


X@PSW

3.
Now enter the Authorisation Code supplied and press ENTER

NB:  If an existing Authorisation Code has been stored in a temporary library during the installation procedure, copy it back to the XAN4 library.

· Store the security code form in a safe place 

X-Analysis Port

X-Analysis uses JT400 Driver to access data on iSeries. The following ports should be accessible on iSeries:

· Port 8471 for JDBC Database requests.

· Port 8475 for Command Call.

· Port 8476 for Sign On.

Initialization of an iSeries Application for X-Analysis 

Before X-Analysis can be run, the application cross-reference library, the application repository, has to be built. The initialisation process takes care of setting-up of this cross-reference database. 

The X-Analysis Application overview (X4WRKAPP) interface can be used to initialise X-Analysis.

Set the Library List

Change the Library List to ensure the following sequence:

1. XAN4

2. QGPL

3. QTEMP

Use the command EDTLIBL to set the library-list.

Edit Library List

 Type new/changed information, press Enter.                                     

   To add a library, type name and desired sequence number.                     

   To remove a library, space over library name.                                

   To change position of a library, type new sequence number.                   

Sequence                   Sequence                  Sequence                  

  Number    Library          Number    Library         Number    Library        

   010                        120                       230                     

   020      XAN4              130                       240                     

   030      QGPL              140                       250                     

   040      QTEMP             150                                               

   050                        160                                               

   060                        170                                               

   070                        180                                               

   080                        190                                               

   090                        200                                               

   100                        210                                               

   110                        220                                               

 F3=Exit            F5=Refresh             F12=Cancel                           

 Library list changed.                                                          

EDTLIBL Command screen

Work with X-Analysis/4 Applications

Type the command X4WRKAPP and press Enter. The following is presented.

X-Analysis/4           Work with X-Analysis/4 Applications    Databorough Ltd.

 XARWKAPP                                                              05:52:26

                                                                    10 Mar 2005

 Enter options, press Enter.                                                   

 1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=Notes 8=Libraries          

 9=Variable Calls 10=App areas 11=Reports 12=Initialise 13=Build data model    

 14=Offline menu 15=Objects 16=Exclusions 17=I/F Files 18=Program standards    

     X-ref Lib   Text                            Company/division               

     XAN4CDXA    XAN4CDEM Tutorial System

     XAN4CDXW    Web demo application                                                                                    

  F1=Help   F3=Exit  F6=Add    F10=Cmd Line      F12=Cancel   F24=More Keys     

X4WRKAPP Command screen

Press F6 to add an Application.

X-Analysis/4           Work with X-Analysis/4 Applications    Databorough Ltd. 

 XARWKAPP                                                              18:37:51 

                                                                    10 Mar 2005 

  X-ref Library. . . . . . . . .    CUSLIBXA                                  

  Text . . . . . . . . . . . . .    PROD                                        

  Company/division . . . . . . .    Databorough Limited                         

  Index src files. . . . . . . .    A                                           

  Process var & bound calls. . .    Y                                           

  Include obsolete source  . . .                                                

  Build data model . . . . . . .                                            

  Data model match value   . . .                                                

  TCPIP address  . . . . . . . .                                                

  User iD  . . . . . . . . . . .                                                                                   

X4WRKAPP - Add Application screen

Enter the details of your application, as detailed below, and press Enter.

X-ref Library:
The name of the cross-reference Library. Please choose a name that has not been used before on the system.  Use the command
CHKOBJ OBJ(QSYS/Libname) OBJTYPE(*LIB)
or
WRKLIB LIB(Libname)
to check this.

Text:
The description of the application.

Company/Division:
Optional description of the company.

This adds a new application as shown below:

 X-Analysis/4           Work with X-Analysis/4 Applications    Databorough Ltd.

 XARWKAPP                                                              05:52:26

                                                                    10 Mar 2005

 Enter options, press Enter.                                                   

 1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=Notes 8=Libraries          

 9=Variable Calls 10=App areas 11=Reports 12=Initialise 13=Build data model    

 14=Offline menu 15=Objects 16=Exclusions 17=I/F Files 18=Program standards    

    X-ref Lib   Text                            Company/division                

    CUSLIBXA    Demo Application                Databorough Limited

F1=Help   F3=Exit  F6=Add    F10=Cmd Line      F12=Cancel   F24=More Keys      

X4WRKAPP Command screen after adding a new application

The Cross-Reference Library has been created.

Libraries

Select Option 8 to assign the Source and Object Libraries This screen is used to set up the source and object libraries for an application. These libraries can then be used when initialising the application and for any other commands which need this information. Sequence determines the order in which the libraries are placed in the library list.

Following screen is presented when adding libraries to a new X-ref library.

X-Analysis/4   Work with X-Analysis/4 Application Libraries   Databorough Ltd. 

 XARWKLIB                                                              15:25:06 

                                                                    10 Mar 2005 

 Selected x-ref Library -> :   CUSLIBXA                                        

 Enter options, press Enter.                                                    

 2=Change    4=Delete    5=Display                                              

    Type Sequence Library                                                       

 F1=Help        F3=Exit        F6=Add         F12=Cancel     F16=Print        

X4WRKAPP Libraries screen

Press F6 to add the names of the Source and Object Libraries associated with application, and press Enter. Repeat the steps for each Library. Press F3 when all libraries have been defined.

Note that all Data and Program libraries must be entered as Object libraries i.e. of Type ‘O’.

X-Analysis/4   Work with X-Analysis/4 Application Libraries   Databorough Ltd. 

 XARWKLIB                                                              18:48:47 

                                                                    10 Mar 2005 

  X-ref library.     CUSLIBXA                                                   

  Type . . . . .     O         (O=Objct,S=Srce,V=Var.Objct,U=Var.Srce,M=Model)  

  Sequence . . .       1.00                                                     

  Library. . . .     CUSLIB                                                                                                                                          

X4WRKAPP - Add Library screen

The Type may be any one of the following:

· O=Object

· S=Source

· V=Variant Object

· U=Variant Source

· M=Model

While the source library contains the uncompiled source files, the object library comprises the compiled objects for the same.

In addition to setting up standard source and object libraries you can also enter the names of variant source and object libraries.

Variant Object and Variant Source Libraries 

A Variant Object Library is a library, where objects with the same name as those already existing in the base library are kept.

The source files of such objects are placed in libraries known as the Variant Source Libraries.

When entering variant source and object libraries you should associate source libraries with object libraries by assigning the same sequence number or the same sequence number with a decimal increment.

If there is large number of objects in a Variant Library(s), then it is recommended that a separate X-Ref Library be created.

Synon Model Libraries

In order to analyse a Synon application, the Synon model library(s) can be specified by putting the library type as "M". The Initialisation process picks the Data model information in the Synon model library(s) when creating X-Ref library.

Libraries added to a X-ref library are shown below.

X-Analysis/4   Work with X-Analysis/4 Application Libraries   Databorough Ltd. 

 XARWKLIB                                                              18:48:47 

                                                                    10 Mar 2005 

 Selected x-ref Library -> :   CUSLIBXA                                         

 Enter options, press Enter.                                                    

 2=Change    4=Delete    5=Display                                              

    Type Sequence Library                                                       

    S      1.00   CUSLIB                                                        

    O      1.00   CUSLIB                                                        

X4WRKAPP Libraries screen after adding libraries to an application

Press F3 to exit.

Initialisation

The initialisation can now be executed.  Select Option 12 to do this and press Enter.

                       Initialise X-Analysis/4 (XA4INITP)      

 Type choices, press Enter.                                    

 Library for X-Ref database . . . > CUSLIBXA      Name         

 Submit job . . . . . . . . . . .   *YES          *YES, *NO     

Press Enter.

The following screen will be presented, and a batch job is submitted on pressing enter.

                        Initialise X-Analysis/4 (XA4INIT)                  

 Type choices, press Enter.                                                

 X-Analysis Library . . . . . . . > CUSLIBXA      Name                     

 Object Libraries . . . . . . . . > CUSLIB        Name                     

                + for more values                                          

 Source Libraries . . . . . . . . > CUSLIB        Name, *NONE              

                + for more values                                          

 Index Source Files . . . . . . . > *ALL          *CHG, *NO, *ALL, *UPG    

 Include obsolete source  . . . .   *NO           *YES, *NO                

 Process variable & bound CALLS   > *YES          *YES, *NO, *ALL, *SRC    

 Non iSeries Code TCPIP Address .   *NONE                                  

If the Submit job option is entered as *NO then the initialisation process takes place interactively.

X-Analysis Library
The X-Analysis cross-reference library.

Object Libraries
The names of the object libraries to be initialised.

Source Libraries
The source libraries for the Application

Index Source files
Specify whether or not to create indexes over the source files. These indexes will allow the immediate display of where used data. They may be required for the generation of the data model, depending on which options are taken. If the indexes are not built now they can be built for an individual source member at the time it is viewed through the X-Analysis browser. 

If you do not have the source files you cannot index them. You can exclude individual source files from the indexing process by entering records in the file XSRCPFEX. This file is duplicated into the cross-reference library from library XAN4 retaining any records already there. Choose from:

· *ALL - Build the indexes; replace any current indexes

· *NO - Do not build the indexes.

· *CHG - Build the indexes. Only update the current indexes where the source has changed since the creation of the index

Include obsolete source
Choose whether to include obsolete source or not. Obsolete source is defined as source members for whom there is another source member with the same name or similar attributes higher up in the load library list.
Process variable & bound CALLS
This parameter allows you to control how certain program references are processed. These program references are the bound modules and service programs and any references which can be determined by reference to the source code.

If source files are indexed, this option gives more detailed information for structure charts and data flow diagrams.  Calls to variable program names and bound calls will be interpreted and added to the program cross-reference data. This will ensure complete data for structure chart diagrams and data flow diagrams.

· *YES – Process variable calls, bound calls, service programs and modules.

· *NO – Do not process variable and bound calls.

· *ALL – Process variable calls, bound calls, service calls and modules and scan program sources for additional reference to the prototyped calls

· *SRC – Process variable calls and process calls to bound procedures only by scanning the source code.

Non iSeries Code TCPIP Address
If you are loading JAVA Source Code from your PC into X-Analysis then apart from entering the IP Address of your PC, the iSeries User ID and Password need to be entered as well.

· Enter the numbers and full stops without any spaces
Ensure that the correct details are displayed. Press Enter to start build process.

For using  Application Areas (Option 10), Offline menu (Option 14) and Program Standards (Option 18), the Application Overview Module has to be purchased.

Generating the data model

X-Analysis provides a data-modelling environment on the iSeries.  It can reverse engineer a current application and then automatically generate the data model and process model.  The (logical) data model, or entity relationship diagram, is derived from the physical data model, which is implicit in the application. 

The next step is to generate the Data Model.  To do this, select Option 13 on the Work with X-Analysis/4 Applications menu.

X-Analysis/4           Work with X-Analysis/4 Applications    Databorough Ltd. 

 XARWKAPP                                                              10:16:04 

                                                                    10 Mar 2005 

 Enter options, press Enter.                                                    

 1=Authorities 2=Change 3=Copy 4=Delete 5=Display 7=Notes 8=Libraries           

 9=Variable Calls 10=App areas 11=Reports 12=Initialise 13=Build data model     

 14=Offline menu 15=Objects 16=Exclusions 17=I/F Files 18=Program standards     

    X-ref Lib   Text                            Company/division                

 13 CUSLIBXA    Demo Application                Databorough Limited             

F1=Help   F3=Exit  F6=Add    F10=Cmd Line      F12=Cancel   F24=More Keys     

Press Enter

                        Initialise Data Model (XDMODELP)                        

 Type choices, press Enter.                                                     

 Library for X-Ref database . . . > CUSLIBXA      Name                          

 Submit job . . . . . . . . . . .   *YES          *YES, *NO                     

                                                                       Bottom 

 F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display    

 F24=More keys                                                                  

Check if the defaults are correct and press Enter.

This runs the XDMODEL, the principal command required to run the complete modeling process.

                     Generate Prototype Application (XDMODEL)                  

 Type choices, press Enter.                                                   

 Function Library . . . . . . . . > XBMAILERXA    Name                        

 Add/replace model data . . . . .   *REPLACE      *ADD, *REPLACE              

 Site Library . . . . . . . . . .   *FUNLIB       Name, *FUNLIB               

 Add/replace site data  . . . . .   *REPLACE      *ADD, *REPLACE              

 Function type  . . . . . . . . . > *GRIDS        *GRIDS, *LISTS, *NONE       

 X-Analysis Application Area  . .   *ALL          Name, *ALL                  

 Data Libraries . . . . . . . . .                 Name                        

                + for more values                                             

 Synon Model Libraries  . . . . .   *NONE         Character value, *NONE      

                + for more values                                             

 Derive Foreign Keys  . . . . . . > *PGMLOGIC     *DATABASE, *DATABASEA...    

 Tolerance Value  . . . . . . . .   *NOMAX        Number, *NOMAX              

 Allow unmatched field names  . .   *PREFIX       *ALL, *PREFIX, *SUFFIX...   

 Use ref. fields for deriving . .   *NO           *NO, *EXACT, *PREFIX, *SUFFI

 Use field texts for deriving . .   *NO           *AND, *OR, *NO              

 Overrides Library/Diagrammer . .   *DGM          Name, *DGM, *FUNLIB         

· Please refer to the X-REV User Manual for further details regarding Option 13 i.e. Building the Data Model.

You should attempt to build the data model only if you have purchased the X-Rev Data Modeling Module.

X-Analysis Setup

Installing X-Analysis Pre-Requisites

The installation of X-Analysis requires the following Pre-Requisites:

1. Java Runtime Environment(JRE) 1.4.2 or above, and

2. Support JARs/DLLs.

For installing the X-Analysis Pre-Requisites double click on XAPrereqs5_6.exe.
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X-Analysis Pre-Requisites Setup – Startup dialog

Click Next.

[image: image2.png]=lolx]

Select Installation Folder
This i the foder where %-Anslysi Pre-Reauisites il be installd.

o install i this Folder, cck "Next”, To installto a diferent flder, enter tbelow or lck

Eolder:

JEiProgram Fiesipataborought Browse,

Advanced Tnstaller

<ok =





X-Analysis Pre-Requisites Setup – Select Installation Folder

Change the destination directory, if required.  Click Next.
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X-Analysis Pre-Requisites Setup – Installation Dialog

Click on Install to begin the installation process.
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X-Analysis Pre-Requisites Setup – Finish Dialog

The installation of X-Analysis Pre-Requisites is now complete. Click Finish to close the dialog.

Installing X-Analysis

For installing the X-Analysis double click on XASetup<Version Number>.msi. 

Note: Version Number may change with a different release.
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X-Analysis Setup Dialog

Click Next.
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X-Analysis Setup – Installation

Click Install.
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X-Analysis Setup – Finish Dialog

Once the installation is complete the above dialog is presented. Click Finish to close the dialog.

A program group called X-Analysis is created having short cuts for:

	· X-Analysis Help 

· Uninstall X-Analysis 

· Data Transfer Utility

· Read me

· X-Analysis (Offline)

· X-Analysis Configurator 

· X-Analysis Tools

Activate Port Listener

Initialize Java Code

X-Browse Configuration Wizard

· X-Analysis (Online)
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X-Analysis Start up folder


Configure X-Analysis

Windows Start Menu > Programs > X-Analysis > X-Analysis Configurator pops up a configurator dialog which allows user to configure basic X-Analysis settings.
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X-Analysis Configurator

Here user can pick the Language, Host code page, server timeout and structure chart levels. 

Running X-Analysis

Start X-Analysis from Windows Start Menu > Programs > X-Analysis > X-Analysis (Online). The X-Analysis Sign on dialog is displayed.
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X-Analysis Sign on dialog

1. Enter the TCP/IP address, or the Computer Name or Network ID of the iSeries to be accessed.

2. Sign on as a specific user using iSeries profile. The User Profile Password setting may be case sensitive, if this option is selected in the X-Analysis Configurator.

3. Click OK.

X-Analysis presents List of Application Libraries screen.
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Application Libraries screen in X-Analysis

X-Analysis  brings up the application libraries screen listing the registered applications.

The installation process registers a demo application CUSLIBXA.

Status bar

Status bar on X-Analysis window is divided into six sections. They are:

· General message section

· Host Name section

· User Name

· X-Analysis Library section

· X-Browse Library section

· Database Library section

· Data Model information section
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X-Analysis status bar

The sections hold relevant information at different stages of navigation. The data model information section reflects whether the Data Model information has been built for the current application being browsed. If the data model is built, its shown with the green background else it’s grayed out. The status bar below gives one such state.

Tool bar buttons

The tool bar buttons with their specific purpose are tabulated below:

	Function
	Button
	Purpose

	Return
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	Returns to the previous screen.



	Print Preview
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	Presents a print preview of the diagram on the screen.



	Print
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	Prints the contents of the view.



	Application Properties
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	Displays Application Property Dialog for selected application.



	Member List
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	Displays the member list for the selected source file and library.



	Object List
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	Displays the object list for the selected source file and library.



	Jump To
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	This displays all the options available for a particular member for faster access viz., Browsing of source code, Viewing Data Flow Diagram, Structure Chart and more.



	Object Where Used
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	Displays all the instances of a particular object in an application wherever referred.



	Variable Where Used
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	Displays all the instances of a variable used in the source listing.



	Zoom (source browser)
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	This option displays the source code of a selected member in the Source Browser.  

Select a member by clicking on it to view its source.



	Data Flow Diagram
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	Presents the Program/Object centered Data Flow diagram. To view the data flow diagram of a particular object, the object should be selected from the member list first. Relevant message is shown if no data is present for the selected object.



	Structure Chart
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	Displays the structure chart of the selected object. Message is shown if no data is present for the selected object.

	Position to

Search Text
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First button is the Position to button. Second button is the Search Text button.
	Positions to the Object/Member/Sequence No. specified in Position to/ Search Text box on the View. Search Text is available on the Source browser, Member and Object list view. On Member and Object list view it works on the Description column only.

Alt+P sets focus on the Position to/ Search Text box and Shift+F4 is the short cut key for the Search Text button. 

	Bookmark
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	Invokes the Bookmark manager.



	About
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	Displays the version and copyright details of the product.




Menu bar items

The Menu bar comprises the following menus and menu-items. evil

Menu-items on the menus are enabled, disabled, added and changed depending on the view. 

	Menu / Menu-item
	Purpose

	File
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	Connection: Displays connection status and the job details.

Show Java Console: Displays Java console associated with the current instance.

Print: prints the contents on the view. 

Print Preview: Brings up the print preview of the view.

Print Setup: This option allows for changing margins, paper source, paper size and page orientation for the entire document.

Return: This option returns to the previous screen.

Exit: Exits X-Analysis.


	Application
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	Properties…: Displays the properties for the selected application.



	Action
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	Jump To: Pops-up a dialog for faster access to various object specific views.

Position To: Positions on the List/View to the Object/Member/Sequence No. specified in Position to Box.

Search Description/Text: Its available on the Source browser, Member and Object list views.

Object List: Displays Work with Objects dialog.
Member List: Displays Work with Members dialog.

Variable Where Used: Displays all the instances of a variable used.

Variable Where Updated: Same as Variable Where Used, but displays only those source lines where the field is updated.

Bookmark…: Invokes the Bookmark manager for more than one bookmark.

	View

[image: image31.png]Detail

Experd Level
Collpse Lovel
Expen Al

Subset.
Refresh

Source Level

Source Cods.

Indented source

Pseuda Cod.

Busiress Ruls Corl.
Busiress Rules Peeudo Code

FIawWERBrE i 1 it

Set Font
Default Font:





	Detailed DFD/SC: Brings up the detailed view of Diagram/Charts.

Expand Level: Specific to Structure Charts.

Collapse Level: Specific to Structure Charts.

Expand all: Specific to Structure Charts.

Subset: Subsets the Member/Object List Display.

Refresh: Re-generates the relevant view.

Set Font: Sets the display font on the source browser view.

Default Font: Reverts to the default font.



	Object

[image: image32.png]Zoom Source
ihere Used

Data Flow Diagram
Structure Chart Diagram
Program Structure Chart

Ametate
ark For Dacumenter
ksl For Documenter.

Inyske Kerwse






	Zoom Source: This option opens object source browser.

Where Used: This option displays the object where used screen.

Data Flow Diagram: Presents the data flow diagram.

Structure Chart Diagram: Displays the structure chart diagram.



	Window
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The windows menu shows a chronological list of windows that have been opened by the User to reach the current window. First five views appear as Menu items. If there are more than five windows open then the rest are shown under the ( Windows… submenu item.
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Displays the history of the options taken.



	Help
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	Help: Pops-up view specific help.

Help Topics: Opens the first page of help. 

About X-Analysis: Displays copyright and registration information. 


For information regarding the advanced toolbar and menu bar options, refer to Appendix A.

Right Click Popup Menu

This menu pops-up when an object or a source line is right clicked.
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	<Object Name> Name of the object to work with

Zoom Source: Brings up the object’s source listing

Structure Chart Diagram: Presents the object’s Structure Chart

Data Flow Diagram: Presents object’s Data Flow Diagram

File Field Details: Details of the fields of the file

Object Where Used: Object’s reference information

Variable Where Used: Find usage of a variable

Variable Where Updated: Same as Variable Where Used, but displays only those source lines where the field is updated.

File/Field Where Used: Find usage of a field in that file. <Specific to Source Browser view>.
File/Field Where Updated: Same as File/Field Where Used, but displays only those source lines where the field is updated in that file.<Specific to Source Browser view>.
Member X-ref: This option appears for a variable in Programs




Apart from Zoom Source and More Info, all the other Right Click menu options on an object from a Variant Library are disabled.

Application Libraries View

Application Libraries view is the first X-Analysis view. It lists all the applications added using X4WRKAPP command on the iSeries.

Work with Application

Application library can be selected in the following ways:

· Expanding the application node by click on the “+” sign next to an application X-Ref library.

· Single-click on an application.

· Double-click on an application to bring up Source Files listing.

On the List of Application Libraries, click on the “+” sign next to an application, say, the XAN4CDXA - XAN4CDEM Tutorial System.
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List of Application libraries

This expands the application node, listing the sub-items, Files, Programs, All objects. The Application areas, if created for the application, are also listed.
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Application library expanded

Application Properties

[image: image136.png]Settings for an application can be displayed at any stage while browsing through the application. To display application properties click Application Properties button on the tool bar or select Application > Properties from menu bar.
The dialog lists the Object and Source libraries associated with the application.

The default Application Folder is created under <Default Drive>:\Program Files\Databorough\X-Analysis\<IP Address of Host>\ in the name PCF_<Application Library>. 

If working in offline mode, then instead of a folder named after the IP Address of the host computer, a folder named ‘Offline’ is created.
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Application Properties Dialog

Work With Objects

The Object list dialog is presented for the selected Application Library, when opting for Work with Objects on right-click menu or clicking on Object list button on tool bar.
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Work with Objects dialog

Double-click on the Files item under CUSLIBXA, alternatively right-click on FILE and select Work with Objects option; this presents an object list dialog. 

The default library selected is *ALLUSR, and it prevents any object from the cross reference library to be displayed.

The Type/Attribute is set to *FILE/PF. Click on OK button to get to the Object list. The list also shows the object’s creation, used and changed dates.
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Object list of PFs 

Similarly, double clicking on the Program item under CUSLIBXA also brings up the Work with Objects dialog, but the Type/Attribute is set to *PGM/*ALL. Double clicking on All Objects or clicking on the Object List button sets it to *ALL/*ALL.

To narrow down the search, the Object Name on the Object group may be mentioned as well. It can be :

· *ALL

· Member Name (maximum 10 characters long).

· Initial characters of member name followed by an asterisk e.g. C*, OE*, etc.

Besides the other settings, following Functional Attributes can also be specified on the Object List dialog:

Component Status:

*A
Parent or top-level program


i.e. calls other programs but is not called itself.

*B
Program is called by another and also calls other programs.

*C
Program at the end of a program tree – does not call other programs.

*D
Stand-alone program

Function Type:

This describes the function of the object and is based on COOL:2E definitions.

· The Function Attributes apply to program type objects.

The first screen is sorted on Object Name in ascending order.  To change the sort order or to sort on any other column, click on the respective column heading.

Jump To dialog can be invoked by pressing Enter on the Object list view. This puts the object on that row in the Object/Variable textbox of the Jump To dialog. From here the user can select the desired option. Also, the user can right-click on the row to bring up the pop-up Menu to select an option.

Subset List

This option allows to subset the current Object List in the view.  Select Subset on the View menu in Object list view.

The criteria is now limited to specifying the:

1. Object Name

2. Type

3. Attribute

4. Object Text

5. Functional Attributes

Source File View

Source File View contains qualified names of all the source files present in the application. This view is reached by double-clicking (OR Right-click option, Work with Source Files) on Source Files sub-item on an application in the Application Libraries View.
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Source Files List

Double-click on a source file to bring up Member List view listing all members of the source file.
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QRPGSRC Member List
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However, the Member List may be brought up by using the Member List button as well.

Here user can specify the criterion to prepare a set of Members to work with.

1. Select Source File and Library using the drop list. Selecting *ALLUSR as the library name, prevents the source files in the cross reference library from getting displayed.

2. The Member Name on the Member details group can be:

· *ALL

· Member Name (maximum 10 characters long).

· Initial characters of member name followed by an asterisk e.g. C*, OE*, etc.

3. Select type from the drop list.

4. Click OK

The list of members for the specified criterion is presented in the Member List View.

The first screen is sorted on the Member Name in ascending order.  To change the sort order or to sort on any other column, click on the respective column heading.

Subset List
To view the subset of the current Member List, select Subset on the View menu in Member list view.

The criteria is now limited to specifying the

1. Member Name

2. Member Type

3. Object Text

Jump To
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The primary requirement of an analyst working with a case tool is to get quick and enough information about an object. X-Analysis facilitates this by providing faster access to the objects using the “Jump To” utility. This utility is available from any screen using the Jump To button on the toolbar.

Jump To displays all the options available for a specified member, object or variable for fast access to Source Browser, Data Flow Diagram, Structure Chart, Object Where Used, Source X-Reference and Variable Where Used. 
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Jump To Dialog

Information about an Object

More Info

More Info option provides detailed Object Information like name, library, type, attribute, etc. This option is available on the right-click popup menu only.

More Info option selection presents Detailed Object Information dialog. This dialog has information depending on the type of object. Generally, it presents object details viz. Name, Object Description, Library, Type and Attribute.
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More Info Option

For program type objects it also presents - Function Type, Roll-up Group and Component Status.
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More Info for a Program Object
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For a PF object, More Info presents the following details:
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More Info for a PF object 

Data Flow Diagram

Data Flow Diagram is the pictorial representation of the program/object, showing the files and programs accessed by the subject program. The types are:

· Program centered

· Object centered

· Command centered

Program Centered 

Files can be accessed for Input, Output or Update by the program.  Data Flow Diagram displays the logical flow of the data. Workstation and/or Printer files used by Program are shown as well. The program’s DFD also displays the programs called and the programs calling it. Such diagrams are Program centered Data Flow Diagrams.
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Program Centered DFD
Command Centered

A Command Centered Data Flow Diagram is same as Program Centered Data Flow Diagram except that the object for which Data Flow Diagram is drawn is a Command object.

The legends bar at the bottom of the screen depicts type of objects displayed on DFD. Program Centered DFD and Command Centered DFD both display same legends bar.
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Program/Command Centered DFD Legend Bar
Object Centered

An Object Centered Data Flow Diagram displays the object’s usage by various programs and Logical views.
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Object Centered DFD
The Object Centered DFD’s legend bar, at the bottom of the screen, depicts the type of object displayed
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Object Centered DFD Legend Bar
Detailed Data Flow Diagram

Detailed data flow diagram displays field details of the objects present in the data flow diagram.

[image: image52.png]. 2

oeo0z oE00s
Ordar Enairy Pt Involoss

cusTs
Customars

FIELD USAGE OF OBJECTS ASSOCIRTED WITH CUSTSL3

1 Input oE00z Order Enquiry
e Y 4 Update/output 0E00L Customer Enquiry/Maintena
nput: cusmo - Prospect No
oucpuc: cusmo - Prospect No
2 Taput oE006 Print Invoices
Te/output 0E008 Order ERtEY
nput: cusmo - Prospect No
oucpuc: cusmo - Prospect No
nput: XUGTUA - Credic Limic
Oucpu: oo - Distributor
Oucpu: XUFOVD - Last Pay
3 Update/output OE001 Order Entry

Oucpu: XUGTVA - Credic Limic

nput: cusmo - Prospect No




Detailed Object Centered DFD
Object Convention

The Data Flow Diagram of a selected object can have different types of items. 

Main for Object Centered DFD
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	Depicts the file for which DFD has been build. It has connecting lines with arrows pointing to the objects it accesses, is accessed by, sends input to, takes input from, or gets updated.


Main for Program Centered DFD
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	Depicts the program for which DFD has been build. It has connecting lines with arrows pointing to the objects it calls, is called by, sends input to, takes input from.


Main for Command Centered DFD
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	Depicts the command for which DFD has been build. It has connecting lines with arrows pointing to the objects it calls, is called by, sends input to, takes input from.


Input
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	Depicts the input file to the main program. It has a connecting line with an arrow pointing into the file.


Output
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	Represents the output file. It has a connecting line joining it to the main program with the arrow pointing out of the file.


Update
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	Depicts the update file. It has a connecting line with arrows at both ends showing data sharing with the main program.


Input Data Area
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	Depicts the input data area to the main program. It has a connecting line with an arrow pointing into the file.


Output Data Area
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	Represents the output data area file. It has a connecting line joining it to the main program with the arrow pointing out of the file.


Update Data Area
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	Depicts the update data area file. It has a connecting line with arrows at both ends showing data sharing with the main program.


Printer
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	Represents the programs used for printing. It has a connecting line joining it to the main program.


Work Station
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	Represents the programs used for display. It has a connecting line joining it to the main program.


Called Program
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	Represents the programs called by the main program.


Calling Program
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	Depicts the program which calls the program whose Data Flow Diagram has been constructed. The arrow head points out. 


Access Path
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	Depicts the logical file related to the parent object.


Command
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	Depicts Command object – calling parent object, or called by parent object.


Input & Output file
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	Represents an input and output file.


Update & Output file
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	Represents an update and output file.


Input file to Trigger Program

	
[image: image70.wmf] 


	Represents an input file to Trigger Program.


Update file to Trigger Program
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	Represents an update file to Trigger Program.


The above items are for a program centered DFD. In case of object centered DFD, the programs using the object as input, output, update are shown as below:
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	Program using the object as input.
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	Program using the object as output.
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	Program updates the object.


The linkages and arrows are depicted in the same fashion as on program centered DFD.

Field Usage

[image: image140.png]


Field Usage information of the file can be displayed by clicking on the button available on the top left/right corner out side the object. It lists the file fields used by the program.
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Field usage in X-Analysis informer dialog

The dialog lists the parameters passed to the called programs for Program to program link.

If the Data Flow Diagram for an object has Variant Objects under its purview then they are indicated by the name of the Variant Library before the Object Names.
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DFD of CUSTS with Variant Objects displayed

In the above diagram, VA02 and VA03 are the two Variant Object Libraries. Object in a variant library is denoted by <Variant Library Name>/<Object Name>.

Structure Chart

Structure Chart Display gives a graphic representation of how the control passes from one program to another program within the application. The Structure Chart starts with the program specified on the request and grows top down, illustrating all programs invoked by the specified program. 
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Structure chart

Structure Chart legend at the bottom depicts the type of object displayed.
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Structure chart legend bar

Structure Chart can be expanded/collapsed using the button on the lines.
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Detailed Structure Chart 

Detailed structure chart option under View menu brings up the file details, describing the functioning of the object.
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Detailed Structure chart

File Usage

The File Usage Option for an Object selected from a Structure Chart, if available, displays File Name, File Type and Description. This option is available only on the Structure Chart.
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File usage in X-Analysis Informer dialog

Object Where Used

The Object Where Used (OWU) lists all the instances in the application where the specified object has been used/referenced.

On a Member List of DDS sources, right-click on the CUSF object and opt for Object where used.
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Member List view

This produces an Object where used screen listing all the object referring CUSF object. 

In case the OWU is performed on a PF (CUSF in this case), then besides listing the objects using CUSF, the objects using the LFs built on CUSF (e.g. CUSFL3) are also reported. 
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Object Where Used Screen

The source of an object on this list can be reached by selecting that object and pressing Enter key. Alternatively, double-click on the object row.

Double Clicking on an object from the Object Where Used List zooms on to the source line where the first reference has been made. 
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Source List of CUSFMAINT

Double Clicking on CUSFMAINT displays the source list with line 44 selected where the first reference of CUSF is being made. However, there may be more references to CUSF further down the source list.

Source Browser View

Right-click on any member/object on the Member/Object list pops up a menu. This menu can be used to produce the Data Flow Diagram, Structure Chart, etc. of the object. All these options are detailed in the subsequent Chapters. We shall talk about Zoom Source here.

Double-click on any member/object on the Member/Object list also opens the member source in the Source Browser view.

Zoom Source

Source Browser display follows the pattern similar to IBM’s SEU and is equivalent to viewing a source member in SEU browser mode.  However, the Source browser display provides a number of additional powerful features.  This not only allows the user to directly browse another source, but also to continue with another zoom once there.  Further, user can return back to the same point on the previous screen from where the zoom was issued.
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Source Browser View

Note the following on this view:

· The display positions the screen to the beginning of C-Specifications for RPG programs and Procedure Division for COBOL programs. 

· Double-click on the line performs Member X-Reference or Object Where Used depending on whether a variable or object is present on the line, giving preference to Member X-reference, in case it’s a Program. On Physical/Logical Files, Global where used is performed for the field on that line for that file.

· Double-click on the sequence number/Date scrolls that line to become the first line on the view.

· Right-click pops up a menu with the name of the Object/Variable on the top and menu options available on it.

Information about an object on a view can be had by selecting/highlighting the object and 

· Right-clicking on it to bring up context-menu to choose an option.

· Invoking Jump To and selecting an option.

· Double-clicking to bring up a designated view depending on the current view.

In the application more than one source member may exist with same name. For example, in the application XAN4CDEM both, QRPGSRC and QRPGLESRC, have a member ZACUSF. The object ZACUSF corresponds to member ZACUSF in QRPGLESRC, while ZACUSF in QRPGSRC is obsolete. In such case if any information is requested for the obsolete source member, then Obsolete Source Member message is displayed as shown below.

Obsolete Source Members show up only on the Member list. The options possible on obsolete Source Members are Zoom Source and More info…

The right click menu on the source view gives the following options:

· Variable Where Used: Displays source lines where the variable has been used throughout the application.

· Variable Where Defined: Displays source lines where the variable was defined.

· Variable Where Updated: Displays the source lines where the variable has been updated.

· File/Field Where Used: Displays the usage of a field in that file.

· File/Field Where Updated: Displays the source lines where the field in that file is being updated.

· Member X-ref: Displays source lines where the variable has been used, for the Source Member displayed.

Let us examine these options.

Variable Where Used

Variable Where Used (VWU) lists all the Source Lines where the field/variable of a file/program has been used/referenced in the Member source and its associated Device Files and Copybooks, through out the application.

A wide variety of items can be specified including:

Files, Array definitions, Data Structures, Data-Structures sub-fields, Indicators, Key Lists, Data Fields, File Formats, Subroutines, Program Variable, Array Elements, Parameter Lists, Parameters, Key Fields, EXCPT Names.

On Source browser view, take VWU on CSNAME field in OE001 program.
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Variable where used on a field used in a program 
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Variable where used view for a field

Besides other options on right-click menu, File/Field where used and File/Field where updated options are also available on PF/LF source browser view. Here, double-click on the field presents File/Field where used source lines, i.e. those source lines which use the field of that specific PF/LF. 

Variable where used for*ALL/CSNAME implies that all the source lines using the field name CSNAME, irrespective of the file to which it belongs will be presented on the VWU view. 

[image: image141.png]


This Tool bar button brings up a dialog prompting for File and Field to perform Variable where used on. The VWU can be made on *ALL or specific file.
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Variable where used dialog

View Levels

Variable where used allows for seven levels of VWU viewing. The Variable where used request always produces Level 1 information. Higher VWU levels can be requested using View Menu. The VWU levels present the following information:

· Level 1: Direct references to the field.

· Level 2: Direct references to that field and references to any other field that references the first field.

· Level 3: All of the above and also further indirection/references to the field in level 2 referencing the first field. 

· Level 4/Parameters: All of the above and also references where the Field has been passed as parameter.

· Level 5/Cascading Parameters: All of the above and also references where the Field has been passed as parameter in a function which is in turn being called by another.

· Level 6/Aliases: All of the above and also references to all the aliases of the Field.

· Level 7/Maximum Tracking: Tracks the usage of variable or field to maximum level of indirection.
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VWU for *ALL/CUSNO, Level 1
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VWU for *ALL/CUSNO, Level 2
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VWU for *ALL/CUSNO, Level 7

Note, more source lines are presented as higher level of VWU is viewed.

Variable Where Defined

Displays the source lines where the variable was defined. Source Line where the variable CSNAME gets defined:
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Variable Where Defined for OE001/CSNAME

Variable Where Updated

This is same as Variable Where Used, but displays only those source lines where the variable is updated. Source lines where Variable CNAME gets updated:
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Variable Where Updated for *ALL/CNAME

If the application is initialised without source code, then the following options are disabled:

1. Source Zooming

2. Program Structure Chart

3. Field Usage

4. Detailed Data Flow Diagram

5. Variable Where Used

6. Variable Where Updated

7. Variable Where Defined.

8. File/Field Where Used

The File/Field Where Used option is only available on FILE type objects. This option displays the usage of a field in the entire application.
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File / Field Where Used for CUSF/CNAME

File/Field Where Updated

This option is the same as File/Field Where Used, but displays only those source lines where the field is being updated.
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File / Field Where Updated for CUSF/CNAME

Both File/Field Where Used and File/Field Where Updated options are specific to Source Browser view and are available only when browsing *FILE type objects.

Member X-Reference

Member X-Reference lists all the Source Lines where the field/variable has been used / referenced, in the Member source and its associated Device Files and Copybooks.

A wide variety of items can be specified including:

Files, Array definitions, Data Structures, Data-Structures sub-fields, Indicators, Key Lists, Data Fields, File Formats, Subroutines, Program Variable, Array Elements, Parameter Lists, Parameters, Key Fields, EXCPT Names.

Double-click on a field in member source presents the Member X-Reference view. Alternatively, choose Member X-ref option on right-click menu.
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Member X-Ref on a field used in a program

When the Member X-Reference for a sub-item (such as a Data-Structure sub-field, Array Element or File Format) is selected, a list of the sub-item, along with all the references to the parent items, is displayed.  Double-click on the source line to view the source of the object.
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Source lines of object(s) using the field

Note that the last source line comes from OE001DF, a device file. Double-click on this line to zoom into OE001DF source.

Member X-reference allows for five view levels, discussed under Variable where used. 

Appendix A – Troubleshooting

Troubleshooting Specific-user mode

User might face problem(s) using X-Analysis in Specific-user mode because of one or more reasons listed below:

1. Missing JAR/DLL. The following should be available under “..\Databorough\lib” folder:

· boot.jar

· jface.jar

· runtime.jar

· swt.jar

· workbench.jar

· jt400.jar

· izmado.jar

· poi.jar

· batik.jar

· xmlrpc.jar

· inwords.jar

· jsf-impl.jar

· jsf-api.jar

· servlet.jar

· 11100316.LIC

· swt-win32-2136.dll

· izmjniado.dll

If anyone of them is missing, X-Analysis Pre-Requisites should be installed again.

2. The Java bean DLL, XBrowseInvokerBean.dll, might not be registered. Please check for the following:

1. <JRE_HOME>\axbridge\bin\XBrowseInvokerBean.dll

2. <JRE_HOME>\axbridge\lib\XBInvok.jar

<JRE_HOME> is e.g. C:\Program Files\Java\j2re1.4.2_05.

If either of them is not found, copy the axbridge folder under “C:\Program Files\Databorough\X-Browse” to <JRE_HOME> and run the following command on Command Prompt:

regsvr32 "<JRE_HOME>\axbridge\bin\XBrowseInvokerBean.dll".

Regsvr32 is under system folder, C:\WINDOWS\system32. Change path to system folder in case command does not run.

3. Either java.policy file does not exist in <JRE>\lib\security folder OR if exists, does not have “..\Program Files\X-Browse” entries.

In case java.policy file does not exist, copy it from “C:\Program Files\Databorough\X-Browse” to <JRE_HOME>\lib\security folder. Add the following section at the end of the file.

grant codeBase "file:C:/Program Files/Databorough/X-Browse/lib/*" {


permission java.security.AllPermission;

};

grant codeBase "file:C:/Program Files/Databorough/X-Browse/lib/*" {


permission java.security.AllPermission;

};

grant {


permission java.util.PropertyPermission "user.home", "read";


permission java.util.PropertyPermission "user.dir", "read";


permission java.io.FilePermission "C:\\Program Files\\Databorough\\X-Browse\\-", "read, write, delete, execute";

};

4. Logoff after performing the above changes.

Following are some additional Troubleshooting tips to help deal with minor problems.

	Problem encountered
	Probable Cause

	Application does not start with iSeries online option.
	A connection must be established prior to running the Application with iSeries online.



	Cannot see the preview of the diagrams/charts from the Application.


	A printer must be installed and configured for to preview diagrams/charts.



	Running with PC Database does not start the Application. 
	The Database to be used must be registered with ODBC.



	The existing fonts do not print correctly on the diagrams/charts.
	The option exists to alter the font. The selected font is reflected on all the diagrams.


Initialisation Reports

When intialising an iSeries Application for X-Analysis using XA4INIT, the command also produces the log reports. The log reports generated are categorized as:

	· Program Reference Exclusions
	· Missing Object and Source


Program Reference Exclusions

These exclusions are specified in file XAN4/XPGREXCS.

X-Analysis is shipped with file XPGREXCS containing values QRN*, QLE*, QC*, QM*, QS*. The file is duplicated into the user's X-Analysis library.

Any program reference specified in this file is excluded from the X-Analysis program cross-reference database X@XPGRF.

Two reports are produced to list all actual exclusions:

· Program XARRMIVN reports on exclusions from the DSPPGMREF output. 

· Program X@PMX1 lists exclusions from the QBNLPGMI output.

Missing Object and Source 

Various programs in the X-Analysis initialisation process write mismatches to a log. These mismatches are printed out under the following headings:

· References to Objects not loaded

· References to Sources not loaded

· Source Code without Objects

The above reports assist user to interpret the outcome of the XA4INIT command run on an iSeries application.

Configuring X-Analsyis for Generic User mode

Configure XRMTCMD to use Generic mode ONLY if for some reason user specific mode fails.

(Only if TCP/IP connection is going to be used)

Create the XRMTCMD environment

You should have signed on as Security Officer or equivalent at this point in order to create the required user profile.

Execute the command MMC@INST in library XRMTCMD


XRMTCMD/MMC@INST

and press F4.

                      Installation of XRMTCMD (MMC@INST)

 Type choices, press Enter.                                                     

   Library  . . . . . . . . . . .   XRMTCMD      Character value               

   Password . . . . . . . . . . .   XAN4          Character value               

                                                                         Bottom 

 F3=Exit   F4=Prompt   F5=Refresh   F12=Cancel   F13=How to use this display    

 F24=More keys                                                                  

The library must be XRMTCMD.  If another library is specified the TCP/IP connection may not work.

The Password is the password used to logon to X-Analysis from the PC.

This creates a user profile and a message queue both named XRMTCMD. 

The subsystem XRMTCMD is also started.

· The password is required by the Windows user to sign on.

· The following needs to be added to the IPL procedure.

STRSBS XRMTCMD/XRMTCMD

If the MMC@INST is run with insufficient authority, then:

· Stop the XRMTCMD subsystem.

· Run the MMC@INST command again, with the required authority.

Appendix B -  Advanced Toolbar and Menu options

Tool bar buttons

The tool bar buttons not available with basic X-Analysis are tabulated below:

	Function
	Button
	Purpose

	Source Editor (SEU)
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	Invokes iSeries Source Editor.

	Screen design
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	Displays the Screen design for the specific object.

	Documenter
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	Invokes the Document Manager to assist in generation of Application Document.



	Annotate
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	Opens a word document to associate an annotation with the selected object. 



	Annotate Field
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	Opens a word document to associate an annotation with the selected Field.

	Overview Structure Chart
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	Displays the Overview Structure Chart for the entire Application.

	Data Model Diagram
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	Displays Data Model Diagram for the selected Application Area. If no Application Area is specified it displays Data Model Diagram for the entire Application.

	View Data/

Re-engineered Components
	[image: image106.png]



	Invokes X-Browse (if installed) on the local machine for the selected PF. For Programs, list of Re-engineered Components is presented. User can invoke X-Browse for the function or Zoom on Shadow Program. 

	Invoke X-Browse on Data Dictionary
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	Invokes X-Browse (if installed) on the Data Dictionary generated by XREV

	Open Websphere Studio
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	Opens the Websphere Studio. Only available on the Business Rules/JSFs View.


Navigation Pane options

	Functions
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	Presents the Work with Functions dialog, using which the Function List may be displayed. Only the Re-engineered Functions may also be displayed.

	Re-engineered Programs & Screens
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	Displays the Re-engineered Programs & Screens List for the application or selected application area.


Menu bar items

The Menu bar comprises the following menus and menu-items.

Menu-items on the menus are enabled, disabled, added and changed depending on the view. 

	Menu / Menu-item
	Purpose

	File
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	Export to Word: Available on Object/Variable where used lists.



	Application
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	New: Allows adding of a new Application area.

Delete: Delete a selected Application area.

Open Application Folder: Opens application specific folder listing the files in it.

Documenter: Invokes the Document manager.

	Action
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	Data Modeling Diagram: Displays the Data Model Diagram for an application

Document this list…: This option starts documenter for current list.

Overview Structure Chart: Displays the Overview Structure Chart for an application.

Export To Visio: This option exports current Data Flow Diagram to Visio.

Export as XMI: Exports Data Model information to XMI format.

Export as DDL: Exports Data Model information to DDL.

Both the Exporting options get enabled  only in DMD view.

Invoke X-Browse on Data Dictionary: Invokes X-Browse on Data Dictionary information produced by X-Rev.



	View
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	Detailed DFD/DMD/SC: Brings up the detailed view of Diagram/Charts.

Available only on Source Browser view:

Source Level: Displays various levels of the source code.

Indented View: Displays the indented view of the source.

Pseudo Code: Available on Source browser View. Presents the Source lines in the form of English Statements.

Business Rules Code: Available on Source browser View. It highlights business logic code, at different levels. 

Business Rules Pseudo Code: The Source Code in the Business Rules Code view is displayed in the form of Pseudo Code.

Flowchart in MS Visio: This option appears in case of *PGM type files and exports its flowchart into MS Visio.

File Specification: This option is shown when browsing PF/LF source. It displays the record format and key fields.



	Object

[image: image115.png]Zoom Source
ihere Used

Source Edtar (SEL)
Screen Design/Report Layout

Data Flow Diagram
Structure Chart Diagram
Program tructure Chart

v Annotate.

Mark for Documenter





	Source Editor (SEU): Invokes iSeries Source Editor.

Screen Design: Screen Design as on iSeries.

Program Structure Chart: Presents object’s Program Structure Chart

Annotate: Displays Word document to annotate the object.

Annotate Field: Displays Word document to annotate the field.

Mark for Documenter: Marks the object for documentation.

Mark all for Documenter: Marks all the objects in current view for documentation.

Invoke X-Browse: Invokes X-Browse (if installed) on the local machine for the selected PF. For Programs, list of Re-engineered Components is presented. User can invoke X-Browse for the function or Zoom on Shadow Program.


Right Click Popup Menu on View

This menu pops-up when an object or a source line is right clicked.
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	Program Structure Chart: Presents object’s Program Structure Chart

Data Modeling Diagram: Displays object’s Data Model Diagram

LFs/Access Paths: Replaces Source X-reference option when working with Physical Files

Screen Design: Displays Screen Design

Annotate: Displays Word document to annotate the object.

Annotate Field: Displays Word document to annotate the field.

Mark for Documenter: Marks the object for documentation

More Info…: Object details like name, library, type, attribute, etc.

Derive Business Rule: Extract Business Rules.

Re-engineer Bus. Rule Pgms & Screens: Re-engineers the Business Rule Programs and Screens.

Generate JSF, Javabean(s) and UML: Generates the JSF Page and the Javabean source with the same name as the Screen Function Name.

View Data: Invokes X-Browse for the selected PF.
The Program Structure Chart, Screen Design, Mark for Documenter options, along with the three Application Area Maintenance options will only be enabled if the Application Area Module is purchased.


The List of Application Libraries View has its own Right-click popup menu. 

Right-click menu on the X-Reference Library
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	New Application Area: Allows adding of an Application area.

View Archived Records: Opens X-Browse to display archived records.

Subset Entire Library: Submits a batch job to produce subset of entire library.

Derive Business Rules: This command uses the X-Analysis and X-Rev databases to reverse engineer all relevant functionality from legacy programs in the X-Reference Library.                                                                                                                               

Re-engineer Bus. Rule Programs: This option re-engineers functions from an existing program.

Generate JSF and Javabean(s): This would configure the project (if it has not already been configured) with the same name as APPLIB, generate the JSF page and bean of Business Rule Program and finally launch the WDSC.
Relationship Field Matching: Allows XOVRALIAS Maintenance.

Regenerate Data Model and Functions: Starts XDMODEL in batch by locking the application.

Regenerate Functions: Starts batch building of functions by locking the application.

Remove Application Lock: Unlocks a locked application.


Right-click menu on the Sub-library
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	Orphaned Records Report: Displays report of records whose parents do not exist. This is available on Verification and Subset library.

Reinstate: Reinstates archived records. Available only on Archive library.

Work with this Library: Selects the library as data library.

Return to Initialised Library: It reverts to the initialised X-Analysis data and X-reference library.


Right click menu on an Application Area
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	Update Application Area: Allows updating of an Application area.

Remove Application Area: Allows deleting of an Application area.

Application Area Rules: Allows maintenance of Application area rules.

Generate X-Browse Application: Creates X-Browse application on the files in application area.

Derive Business Rules: This command uses the X-Analysis and X-Rev databases to reverse engineer all relevant functionality from legacy programs within the application area.
Re-engineer Bus. Rule Programs: Re-engineers programs in the application area.

Generate JSF and Javabean(s): This would configure the project (if it has not already been configured) with the same name as APPLIB, generate the JSF page and bean of Business Rule Program and finally launch the WDSC.
Export as XMI: Exports Data Model information to XMI format.

Export as DDL: Exports Data Model information to DDL.

Both the Exporting options get enabled  only in DMD view.

Work with Objects: Brings up the Work with Object dialog.

Document Application Area: Invokes System Documenter on the objects held in an application area.

Verify Data Relationships: Produces a verification report listing records breaching the relationship integrity.

Set Subset/Archive Filter: Invokes X-Archive Application to set Archive Filter.

Subset Data: Submits a batch job to produce data subset on the subset filter specified for that application area.

Archive Data: Submits a batch job to produce archive data on the archive filter specified for that application area.




The module wise details of the advanced toolbar and menu options are as follows:

	Module
	Advanced Options Available

	Application Overview 
	· Source Levels

· Source Code

· Indented Source View

· File Specification View

· Pseudo Code

· Business Rules Code

· Business Rules Pseudo Code

· SEU

· Screen/Design Report Layout

· Flowchart in MS Visio

· Export to MS Word

· Export to MS Visio

· Mark for Documenter

· Document Manager dialog

· Mark all for Documenter

· Document this list...

· Annotation

· Program Structure Chart

· Overview Structure Chart

· Delete Application Area

· Update Application Area

· New Application Area

· Application Area Rules

· Document Application Area

· Add to Application Area

· Add to Application Area with Related Objects

· Omit from Application Area

· Open Application Folder

· Change Application Folder



	Subset Data


	· Subset Data

· Set Subset / Archive Filter

· Subset Entire Library



	Data Model Diagram
	· Data Model Diagram

· LF/Access Paths

· Regenerate Data Model and Function

· Data Dictionary




	Archive Data


	· Archive Data

· View Archived Records



	View Data
	· Regenerate Functions

· Relationship Field Matching

· Regenerate Data Model and Functions

· View Data

· Generate X-Browse Application



	Verify Data Relationship


	· Verify Data Relationships

	Business Rules
	· Business Rules Code

· Business Rules Pseudo Code

· Re-engineer Bus. Rule Programs

· Derive Business Rules




Appendix C – Licence Code Request Form
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	License Code Request form


Kindly complete and confirm the details below and fax this form to: +44 1932 859211
Alternatively this can be emailed to sales@databorough.com
	Company
	

	Contact name
	

	Contact email
	

	Telephone
	

	Fax
	

	Address
	

	
	

	
	

	Post Code
	

	Country
	

	iSeries Serial No.
	

	Model
	

	Feature Code
	

	Purchase Order No
	

	Agent or Distributor
	

	Comments
	

	
	


If software is required to be sent and the iSeries is not located at the same address as indicated above please provide the appropriate delivery address and contact details below.

	iSeries Contact
	

	Contact email
	

	Telephone
	

	iSeries Address
	

	
	

	
	

	Post Code
	
	Country
	


	Requested By
	
	Date
	


Position        _______________________________


Unit 12b, Weybridge Centre, 66 York Road, Weybridge, KT13 9DY, United Kingdom Tel: +44 (0) 1932 848564 

Company Registration Number: 01795263                    VAT number:  492 6942 05

Appendix D - Invoking X-Analysis from WDSC for iSeries

In order to invoke X-Analysis from Websphere Development Studio Client for iSeries, the WDSCXAInterface Plug-in is required. The Plug-in is shipped with X-Analysis and on installation it is copied at the following location:

C:\Program Files\Databorough\X-Analysis\WDSCPlugin

If WDSC for iSeries is found on the machine, the plug-in is also placed at:

C:\Program Files\IBM\WebSphere Studio\Site Developer\v5.1.2\eclipse\plugins\ com.databorough.xanalysis.wdscxainterface_1.0.3

THE SUPLLIED PLUG-IN WORKS WITH WDSC 5.1.2.

Start Websphere Development Studio. To ensure that the plug-in is installed on the machine. go to Help > About Websphere Development Studio Client for iSeries. On the presented dialog, click Plug-in Details button. The following dialog is presented displaying the Plug-in Name, its provider and the version.
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Plug-in Details Dialog on WDSC for iSeries

Follow the steps below to browse a library using X-Analysis:

Step 1: On WDSC for iSeries, go to Window > Open Perspective > Remote System Explorer.
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Remote System Explorer Panel

Step 2: Expand the New Connection node. Further, expand iSeries… node.
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Remote System Explorer - Expanded

	Step 3: The Remote iSeries System Connection Dialog is presented. Enter the Connection Name, the Host Name and click on the Finish button.
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New Connection Dialog

	
	

	Step 4: A Sign On Dialog is presented. Enter the User Name and Password for the host.
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Log in Dialog for New Connection

	Step 5: A new connection by the name specified as the Connection Name in the previous dialog is added. All the libraries in the host computer may be viewed by expanding the Library List. However, to view only selected libraries, a Library Filter has to be created.
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New Connection Added

	
	

	Step 6: Expand Work with Libraries node under iSeries Objects. This prompts for specifying Library Filter. Enter the iSeries Library Name. Click Next.
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Add New Filter Dialog

	Step 7: Enter a Filter Name. Select the Owner Profile and click on the Finish button.
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Library Filter Dialog



	Step 8: A new filter is added. Expanding the node displays the library added to the filter. E.g. in the adjacent image the new filter xan4cdxa displays the library XAN4CDXA on being expanded.
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New Filter Added


Step 9: Right Click on the Library Name and select X-Analysis > Browse In X-Analysis.
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Right Click menu on iSeries Library

	Step 10: The X-Analysis Login Dialog is presented. Enter the User Name and Password of a valid iSeries profile and click OK.

In case more than one X-References are build on this library, user is prompted to pick the one to work with.
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X-Analysis Login


Step 12: X-Analysis is invoked and after successful login, it will open up the Source File Listing for the selected X-Reference library.
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Source File List in X-Analysis

	Step 13: Insert another library into the Library Filter, say XAN4CDEM. The new library is displayed along with the already existing libraries.
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New Library Added


Step 14: Expand the newly added library and right click on any object. From the right click menu select X-Analysis > Zoom In X-Analysis.
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Zoom In X-Analysis Option

X-Analysis is invoked and the source of the selected object is displayed.
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Source List in X-Analysis

The document highlights the X-Analysis plug-in functionalities.

Troubleshooting X-Analysis plug-in

In case of any problems, ensure the following:

1. Look for “com.databorough.xanalysis.wdscxainterface_1.0.3" folder under 

“C:\Program Files\IBM\WebSphere Studio \Site Developer\ v5.1.2\eclipse\plugins\ folder.

If not found then copy it from “C:\Program Files\Databorough\X-Analysis\WDSCPlugin” location.

2. Open wdscXaInterfaceResources.properties to confirm that it has the following:

xanalysis.path=C:\\Program Files\\Databorough\\X-Analysis\\

3. Start WDSC for iSeries again.
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